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Windows 10 Setup Tips & Resources 
I n f o r m a t i o n  T e c h n o l o g y  S e r v i c e s  

Revised July 20, 2018 

The First-Time Login – Must Be On-Campus 
1. Make sure your new Windows 10 laptop is on campus when you log on for the first time.   We 

recommend an Ethernet cable (wired) connection for the initial setup, but is not required.  If 
you do not see "Windows will try to connect to MiddleburyCollege" under the password 
prompt, wireless has not been able to establish a background connection and you may need 
to connect using a wired jack or wait for that message to appear. 

2. Start your computer then press any key after the initial time/date screen appears. 
3. Click Other user in lower left. 
4. Enter your Middlebury user name and password when prompted. 

5. Press  or click the  icon to complete the login process.  Be patient as the 
Welcome and initial login process completes. 

Important Basics:  Shut Down, Restart & Sign Out 
The most important things you need to know about your new computer are how to shut it down and 
how to sign out as these processes are different in Windows 10: 

• To SHUT DOWN, RESTART, or put the computer to SLEEP:  Click    then  (Power). 

• To SIGN OUT (formerly Log off):  Click   then your account icon , then Sign out. 

Be sure to check out the last page for valuable resources to get you up to speed 
with Windows 10, including five short videos covering new features! 

Middlebury College Software Management & Self Service 
We use KACE to make software available to you more quickly and 
easily.  The self-service website (http://go/kss/) offers a growing 
number of common software titles that can be installed at your 
convenience. 

Additionally, pop-up dialogue windows having the Middlebury College 
brand (see sample) may appear in the lower right above the task bar, 
offering patches or other important updates.  These are legitimate so 
you may safely follow the prompts.  If you are ever uncertain about the 
validity of a pop-up request, contact the Service Desk (802.443.2200); 
better safe than sorry! 

For more information, visit http://go/KACE/. 

http://go.middlebury.edu/kss
http://go.middlebury.edu/KACE
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Set up your Exchange Account in Outlook 

1. Click the Search Windows icon    at left on the Task Bar, then type “Outlook”. 
2. Click Outlook 2016 when it appears.  The Welcome to Outlook 2016 dialog box will open. 

3. Click .  The Microsoft Outlook Account Setup dialog box displays. 
4. Verify that Yes is bulleted to set up Outlook to connect to an email account, then click 

. 
5. Because you are logged on as yourself, the Add Account dialog box should automatically 

provide your information.  Click  to continue. 
6. Wait until the Add Account dialog box has all 3 items checked (as shown below).  Note:  With 

our email accounts in the cloud, this now can take 10 to 20 minutes to complete!  You can 
continue working on other setup details while this is “thinking.” 

 
a. If you only work with your own email account, simply click .  
b. If you work with other Middlebury email accounts, including FAX accounts: 

i. Check the box beside Change account settings, then click .  
ii. Click More settings, then the Advanced tab. 

iii. Uncheck the box beside Download shared folders to shut off cached mode for 
the other accounts.  Doing this prevents viewing issues (such as missing folders 
or meetings) when using shared accounts.   

iv. Click OK, then Finish. 
7. When the First Things First dialog box appears, select Install updates only then click Accept. 
8. Take a moment to pin Outlook by right-clicking its icon on the Taskbar, then choosing Pin to 

taskbar. 
9. Be patient while Outlook prepares for first-time use.  Check the status bar at bottom 

periodically to monitor progress.  When you see All Folders Are Up To Date you may begin to 
use Outlook or follow instructions to add additional mailboxes. 

Note:  You can minimize Outlook and continue setting up your new computer while this initial 
email process completes. 
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Common Outlook Setting Adjustments 
• If you don’t care for the reading pane, click the View tab, then click the Reading Pane button.  

Select Off from the drop-down list. 
• Wonder where the From and Bcc fields went?  Start a new message then click the Options tab.  

Now click the Bcc and From buttons on the ribbon.  These fields will now appear when 
creating future messages. 

• Did you save any Outlook views from your old computer?  To reapply them, click the View tab, 
then click the Change View button (far left).  Your named views will be available for use. 

Add Another Middlebury Mailbox to your Outlook View [if needed] 

First, check Outlook’s left-hand navigation pane to see if your additional accounts already appear on 
the list; they are now added automatically in some cases.  It takes a little while for the folder contents 
to appear – this is normal.   

Add any missing accounts as follows: 

1. Click Outlook’s File tab; Info is already selected. 

2. Click , then click Account Settings… from the drop-down menu. 

3. Double-click on your email address in the Name column.  The Change Account dialog box 
opens. 

4. Click .  The Microsoft Exchange dialog box opens. 

5. Click the Advanced tab. 

6. Click .  The Add Mailbox dialog box opens. 

7. In the Add mailbox field type the display name (the last name may be enough) of the mailbox 

you want to add and then click .  The mailbox name appears on the Open these 
additional mailboxes list. 

8. Be sure the box beside Download shared folders is UNchecked.   

9. Click .  As with your own account setup, it may take 10 to 20 minutes for the 
account(s) to process.  A “Not Responding” message is normal – Outlook is actually working.  

Click  when the button is no longer grey. 

10. On the Change Account dialog box, click  then click . 

11. Close the Account Settings dialog box. 
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Restore Signatures 
If you only use a few signatures, you can easily recreate them.  Here’s how: 

1. Open an old message from your Sent Items folder, then copy your signature text. 
2. Click File / Options, then click Mail. 
3. Click the Signatures button. 
4. Click the New button, give your signature a name, paste in your information, then click Save. 

 
If you had multiple signatures and saved them from your old computer, here’s how to put them 
where they need to go: 
 

1. Open the folder where you saved your signature files then use CTRL+A to select them all. 
2. Right-click any selected file, then choose Copy. 
3. Launch Outlook, then click File / Options, then Mail. 
4. Hold down the CTRL key when you click the Signatures button.  This opens the empty folder 

where the signatures files need to go. 
5. Right-click in the right-hand pane, then choose Paste.  Your individual signature files are now 

ready for use. 
6. Close the Signatures window, then click OK to save your changes. 

Add Apps (Programs) to your Taskbar or Start menu 

1. Click  ; the Start Menu opens showing a list of all apps, as well as a new tiled area. 
2. Scroll through the list and right-click frequently used apps, such as Word 2016, then select 

More, then Pin to Taskbar (or Pin to Start – the tiled area) for ease of future access. 

 You can also search for apps by name using the Search Windows icon     on the 
Task Bar. 

3. Repeat step 2 as needed for other desired apps. 

 

Pinned apps appear in the specified location (Taskbar or the tiled area of the Start Menu) each time 
you start your computer.  You can drag pinned entries on the Taskbar to reflect the order you prefer. 

 Note the transformation of the Start Menu into two parts.  A list of all programs appears on 
the left and customizable groupings of tiles appear on the right.  The tiling feature is geared 
toward touch screen use.   You can unpin any (or all!) tiles if you prefer a cleaner look. 

 TIP:  You may wish to unpin the following icons from your Task Bar:  .  These are 
shortcuts to the Microsoft Store and Windows Mail (not Outlook!) 
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Restore your Mozilla Firefox Favorites (Bookmarks):  

TIP:  If you try to set Firefox as your default browser, the Settings dialogue opens.  You will need to 
change the Web Browser setting manually by clicking on Microsoft Edge then choosing Firefox from 
the list of installed browsers; Windows 10 wants you to love its new Edge browser! 

If you set up a Sync account on your old computer… 

1. Click the menu button button   at right, then click Sign in to Sync. 
2. Click the Sign In button, then provide the sync email address and password you created 

earlier. 
3. An email message is sent to confirm your request.  Note that this message may end up in your 

Junk Email folder. 

Restore your Internet Explorer Favorites (Bookmarks) 
NOTE:  Microsoft’s new Edge browser icon appears on your Task Bar.  Internet Explorer is installed 
behind the scenes but you’ll need to search for it then pin it. 

1. Launch Internet Explorer. 
2. Select File / Import and Export from the command menu. The Import/Export Settings dialog 

box opens.   

 No command menu?  Right-click the area above the browser’s address field, then 
choose Menu Bar. 

3. Click the radio button beside Import from a File then click . 

4. Check the box beside Favorites.  Click . 
5. Click Browse.  The Select Bookmark File dialog box opens. 
6. Navigate to your cloud storage space (or to wherever you saved your file) using the left-hand 

pane, then click once to select the file you saved from your old computer. 
7. Click Open. The Type or browse to a file: field will now show your selected filename and 

location.  

8. Click .  
9. You will be asked where to place the imported favorites.  Select the Favorites folder. 
10. Click Import.  The message "You have successfully imported these settings" should appear. 
11. Click Finish.  
12. Click the Favorites command on the menu bar; your favorites/bookmarks should now be 

available for use. 

  

https://mediawiki.middlebury.edu/wiki/LIS/Image:Next_button.PNG
https://mediawiki.middlebury.edu/wiki/LIS/Image:Next_button.PNG
https://mediawiki.middlebury.edu/wiki/LIS/Image:Next_button.PNG
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Add Printers 

Network printers have labels showing their Printer Queue Name.  You will need this information 
before you can install the printer on your computer. 

1. Press the Windows key ( ) +  to open the Run dialog box. 

2. In the Open field type \\walnut, then click . 
3. Click in the Search Walnut field at top right, then type a few initial characters of your printer 

name (such as OCH, MNR, BIH, or P01).  Results will be filtered for you. 
4. Right-click the desired printer then select Connect from the drop-down menu. 
5. Click the Install driver button if prompted. 

Set Your Default Printer 
If you have added more than one printer you should specify the one you’ll use most often, otherwise 
Windows 10 will set the default printer to the one used most recently at your current location. 

1. Click   then click   (Settings). 

2. Click . 

3. Click Printers and Scanners at left. 
4. Uncheck the box beside Let Windows Manage my default printer to turn off this feature. 
5. Click the desired printer’s name in the Printers & scanners list, then click the Manage button. 
6. Click the Set as Default button, then close the Settings window. 

OneDrive Setup 
Microsoft’s OneDrive app is already available for use on your Windows 10 computer; you just need to 
set it up for use, as follows: 

1. Use the Search Windows icon    on the Task Bar to look up, then launch the OneDrive 
app. 

2. Provide your email address when prompted, then click Sign in. 
3. Provide your Middlebury username and password if prompted, then click Next. 
4. In the Sync your OneDrive files to this PC window, adjust your sync settings as desired, then 

click Next. 
5. The local OneDrive – Middlebury College folder is created on your computer, and the files 

and folders you specified to sync will begin to appear as they are copied down from the cloud. 

You can adjust syncing and app settings at any time using the blue cloud icon on the Task Bar.  
For more information about OneDrive use, visit http://onedrivehelp. 

http://onedrivehelp/
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Google’s Drive File Stream Setup 
If you prefer to use Google’s Drive File Stream to synchronize files between your computer and the 
cloud, you will need to download and install the application.  Visit http://go/getgdfs/, then sign in to 
Google with your Middlebury email address and password if prompted.  (Note:  If you only work with 
Google files via a web browser then you need not install this software.)   

1. Click the Download for Windows button, then save and run the installer.  
2. By default, Drive Stream Files are stored in the cloud and are available for use only when you 

are connected to the internet. 

For more information about Google apps, visit http://go/gdrivehelp/. 

Using Banner INB, Hyperion & More – New Access Method 
Remote Desktop Services (aka RDS) provides a way to use applications and web pages unsupported 
by Windows 10, or that present security risks due to outdated or unsafe software requirements. 

You must now use RDS on your Windows 10 computer to run the following programs:  Banner INB, 
Hyperion Studio, Perceptive Content (aka Content 7), Hyperion IRC, Famis, and NolijWeb.  Daily users 
of these programs may want to set up easily accessible shortcuts on the Start Menu or Task Bar.  Visit 
http://go/rdswin10/ for specific instructions.  For printer-friendly instructions, see the link to Win 10 
RDS Setup in Brief. 

VPN – Pulse Secure 

  Pulse Secure software used for VPN is already installed on your new computer; you just need to 
specify the server (https://vpn.middlebury.edu ) and save your connection details with a name for 
future use.  Need more details?  Visit http://go/vpn/ and start with step 4 of the Windows section. 

Adjust Display Size of Text, Apps, & Other Items 
New, high-resolution displays bring greater clarity to small objects but you may wish to adjust the size 
of how things appear on your new computer.  Here’s how: 

1. Click   then click   (Settings). 
2. Click System. 
3. Click Display in the left-hand navigation list. 
4. Use the drop-down menu below Change the size of text, apps, and other items.  You may need 

to sign out then back in to see the full effect of your changes. 

http://go.middlebury.edu/getgdfs
http://go.middlebury.edu/gdrivehelp
http://go.middlebury.edu/rdswin10
http://go/vpn/
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Adjust Power Options 
You may feel that your computer goes to sleep often or your monitor shuts down too frequently.  
Here’s how to find the power settings so you can adjust them to suit your needs: 

1. Click   then click   (Settings). 
2. Type Power in the Find a setting field; search results will appear as you type. 
3. Choose Power & sleep settings. 
4. Adjust screen and sleep settings as desired. 

• If you have a dock (port replicator), be sure to scroll down and review Additional power 
settings so you can choose what happens when you close your computer’s lid. 

Setup Dual Monitors 
If you use two monitors, you may want to adjust settings to achieve your desired set up.  Here’s how:  

1. Right-click your desktop, then choose Graphics Properties.   
2. Click Display, then choose Multiple Displays from the menu at left.  Adjust settings as desired. 

Connect to a Projector 
Follow the directions to connect your laptop in a Smart Classroom.  Click the Windows 10 Action 

Center icon (  at far right), choose Project, then select how your display should appear.   

 +  can still be used as a shortcut to call up the projection options. 

Things that are Different 

  New look for the Start icon.  Start Menu now has customizable tiles and groupings. 

 Windows Explorer renamed and redesigned – now called File Explorer. 

 New Sophos Endpoint Protection software with full disk encryption now in place. 

  New Task View supports multiple desktops so you can group related work. 

   New Action Center centralizes alerts and notices. 

 The Show Desktop strip that used to be at the far right of the Task Bar appears to be gone, 
but you can still click there to minimize open apps and display your Desktop.  The hover 
feature that previewed the Desktop is still available with Windows 10, just right-click that area 
then choose Peek at desktop.  
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File Explorer (formerly Windows Explorer) – Easier File Management 
Important Note:  We strongly recommend that you store work-related items on the cloud (OneDrive 
or Google Drive File Stream) or in shared departmental folders on Middfiles. 

Windows Explorer got a facelift and a new name, appearing in Windows 10 as File Explorer.  Along 
with a more logical name, you’ll enjoy its improved views and helpful toolbars that simplify common 
file management tasks. 

 

• Click    [File 
Explorer] on the Task 
Bar. 

• Press  +  . 

HANDY TIP: 

You can change File 
Explorer’s initial view.  
Click File, then Change 
folder and search 
options.  On the General 
tab, you can adjust the 
value for Open File 
Explorer to This PC. 

 
 

New in File Explorer… 

 File drop-down menu 
 Former “Favorites” area now called Quick access.  (See circled item above, left.) 
 New view shortcut buttons in lower right for list and large thumbnail views.  (See circled icons 

in File Explorer screen shot above.) 
 Home, Share, & View tabs with associated ribbons  The View ribbon is shown here: 
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Adding Items to Quick Access 
Here’s how to create locations that will be visible in all your Microsoft programs: 

1. Open File Explorer, then navigate to and open one of your frequently used folders. 

2. Right-click  in the top left. 
3. Choose Pin current folder to Quick Access. 

 
⇒ HANDY TIP:  To create Middfiles favorites to shared department folders that always work – 

even from home using VPN or when using the Middlebury College wireless network -- start 
out by typing \\middcloud in File Explorer’s path field at the top.  Now, double-click to open 
middfiles, then continue navigating until you’ve opened the desired folder.  Lastly, follow 
steps 2 & 3 to make the “enduring” shortcuts. 

Action Center 

  You’ll find this new icon at the far right of your Task Bar.  The Action Center centralizes alerts 
and notices.  See the recommended video found at http://go/win10/ to learn about this new feature 
and how you can customize it. 

Task View 

  This new icon is located on the left of your Task bar.  Task View supports multiple desktops so 
you can group related work.  See the recommended video found at http://go/win10/ to learn how to 
use this new feature. 

Learn About Windows 10 and Features of Office 2016 

We’ve done the work for you and gathered some great ways to learn about Windows 10 and Office 
2016. 

⇒ Explore these “go” shortcuts using your favorite web browser: 

• http://go/win10/ – Collected learning resources to refresh or expand your Windows 10 
knowledge.  Be sure to check out the Recommended Viewing section – five videos share the 
most important features of Windows 10 in just over thirty minutes!  It’s time well spent. 

• http://go/office2016/ – Collected links to information and short courses covering usage 
and new features of Office 2016 products. 

http://go.middlebury.edu/win10/
http://go.middlebury.edu/win10/
http://go.middlebury.edu/win10
http://go.middlebury.edu/office2016
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